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Using This Documentation

This guide explains how to install and configure a Windows operating system on
Oracle’s Sun Netra X6270 M2 server module. This document is written for
technicians, system administrators, authorized service providers (ASPs), and users
who have experience with installing Windows operating systems.

Product Information
For information about the Sun Netra X6270 M2 server module, go to the following
web site:

(http://www.oracle.com/goto/netrax6270m2)

At that site, you can find links and navigate to the following information and
downloads:

■ Product information and specifications

■ Supported operating systems

■ Software and firmware downloads

■ Supported option cards

■ Supported Network Express Modules

■ External storage options

■ Systems Handbook
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Related Documentation
The related documents listed in the following table are available online at:

(http://docs.sun.com/app/docs/prod/nt6270.m2.srvrmod?l=en#hic)

Title Content Format

Sun Netra X6270 M2 Server Module Product
Notes, 821-0936

Late-breaking information about the server
module

PDF
HTML

Sun Netra X6270 M2 Server Module Getting
Started Guide, 821-2123

Basic installation information for setting up the
server module

PDF
Print

Sun Netra X6270 M2 Server Module Installation
Guide, 821-0937

Detailed installation information for setting up
the server module

PDF
HTML
Print option

Sun Netra X6270 M2 Server Module Installation
Guide for Windows Operating Systems, 821-0941

Installation instructions for the Windows Server
operating systems

PDF
HTML

Sun Netra X6270 M2 Server Module Service
Manual, 821-0939

Information and procedures for maintaining
and upgrading the server module

PDF
HTML

Sun Installation Assistant 2.3 Through 2.4 User’s
Guide for x64 Systems, 821-0694

Instructions for using the Sun Installation
Assistant to install the Windows and Linux
operating systems

PDF
HTML

Oracle x86 Servers Diagnostics Guide, 820-6750 Information for diagnosing and troubleshooting
the server module

PDF
HTML

Sun Server CLI Tools and IPMI Tool 2.0 User’s
Guide, 821-1600

Information for using applications and utilities
common to x64 servers

PDF
HTML

Oracle Integrated Lights Out Manager (ILOM) 3.0
Documentation Collection, 820-5523, 820-6410,
820-6411, 820-6412, 820-6413 (formerly called
Sun Integrated Lights Out Manager
Documentation Collection)

Documents covering ILOM features and tasks
that are common to servers and server modules
that support ILOM 3.0

PDF
HTML

Oracle Integrated Lights Out Manager (ILOM) 3.0
Supplement for Sun Netra X6270 M2 Server
Module, 821-0943

ILOM 3.0 information that is specific to the Sun
Netra X6270 M2 server module

PDF
HTML

Sun Netra X6270 M2 Server Module Safety and
Compliance Guide, 821-0938

Hardware safety and compliance information
for the server module

PDF

Important Safety Information for Sun Hardware
Systems, 821-1590

Multilingual hardware safety and compliance
information for all Sun hardware systems

Print
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Translated versions of some of these documents are available at the product site
documentation URL identified earlier in this section. English documentation is
revised more frequently and might be more up-to-date than the translated
documentation.

Documentation, Support, and Training
These web sites provide additional resources:

■ Documentation (http://docs.sun.com)

■ Support (http://www.sun.com/support)

■ Training (http://www.sun.com/training)

Documentation Feedback
Submit comments about this document by clicking the Feedback[+] link at
(http://docs.sun.com). Include the title and part number of your document
with your feedback:

Sun Netra X6270 M2 Server Module Installation Guide for Windows Operating Systems,
part number 821-0941-10.

Product Downloads
To download the latest product software, go to the following web site:

(http://www.oracle.com/goto/netrax6270m2)

At that site, you can find links and navigate to the following items:

■ Tools and Drivers DVD image

■ Sun Installation Assistant DVD image

■ Sun Validation Test Suite (SunVTS) Update
Using This Documentation ix
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PART I Windows Server Installations

This section lists the topics that describe how to install the Windows 2008 (SP2 or
R2) operating systems on your server module.

Description Link(s)

Novice or Experienced Users: Use SIA to
perform an assisted installation of the
Windows operating system. SIA provides the
appropriate system drivers and
platform-specific software.

• Chapter 1, Assisted OS Installation
With Sun Installation Assistant (SIA)

Experienced Users. Manually install the
Windows operating system and the required
system drivers.

• Chapter 2, Getting Started
• Chapter 3, Windows Server 2008

Installation
• Chapter 4, Post Installation of Windows

Server 200

Experienced Users. Reference content for
manual Windows operating system
installations.

• Appendix A, Supported Installation
Methods

• Appendix B, Supported Operating
Systems

• Appendix C, BIOS Defaults For New
Installs

• Appendix D, Downloading the ISO
Image for the Tools and Drivers DVD

• Appendix E, Incorporating Device
Drivers Into WDS Images

• Appendix F, Identifying Network
Interfaces in Windows





CHAPTER 1

Assisted OS Installation With Sun
Installation Assistant (SIA)

SIA makes operating system installation easy. With SIA, all you need to begin is a
licensed copy of Linux or Windows OS distribution media supported for your server
module. All software and required server-specific drivers are supplied by SIA. With
a graphical wizard interface and flexible installation options, SIA brings simplicity,
speed, and reliability to your server module deployments.

To use SIA, simply boot the SIA program from the server module's DVD drive, a
USB flash drive, or from a network image. Check for the latest SIA updates
available. Select your OS distribution from the menu and follow the on-screen
instructions. SIA scans your system to ensure that it has the drivers it needs to
configure your server module components[1]. It also provides you the option of
having SIA check for the latest drivers available. SIA will prompt you for the
appropriate media as needed and any other required information during the OS
installation process (such as license keys).

Note – [1] Some option card drivers are downloaded to the server module, but
require manual installation. Feature enhancements are made to SIA regularly;
therefore, you should check the SIA information page for the latest SIA updates and
supported features (http://www.sun.com/systemmanagement/sia.jsp).

Topics discussed in this chapter include:

■ “SIA Task Overview” on page 4

■ “How to Obtain SIA” on page 4

■ “SIA Documentation Resources” on page 5
3



SIA Task Overview
You can perform the following tasks using SIA:

Note – The supported SIA installation and recovery tasks listed below are server
module-dependent and may vary.

■ Perform an assisted installation of a Linux or Windows operating system on your
Sun x86 server module from Oracle. SIA provides the appropriate drivers and
platform-specific software, eliminating the need to create a separate driver disk.

■ Optionally create RAID-1 volumes on internal storage devices.

■ Optionally upgrade your system’s Integrated Lights Out Manger (ILOM) service
processor (SP), BIOS, and storage device firmware (regardless of the OS on your
server module).

■ Optionally update your SIA session with the latest firmware and drivers.

■ Optionally recover from a corrupt or inaccessible ILOM service processor.

How to Obtain SIA
SIA is provided with most x86 Oracle server module platforms on the SIA DVD. It is
also available as a web download. Regular updates are made available to ensure that
the latest OS versions are supported. To download the latest version of SIA for your
server module, refer to the SIA information page at:

(http://www.sun.com/systemmanagement/sia.jsp)
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SIA Documentation Resources
If you have determined that you want to install a Windows or Linux operating
system on your server module using SIA, refer to the following resources for
detailed installation instructions and forum discussions.

■ Sun Installation Assistant 2.3 Through 2.4 User’s Guide for x64 Systems, 821-0694

(http://docs.sun.com/app/docs/prod/install.x64svr)

■ Sun BigAdmin Feature Article: How to Use the Sun Installation Assistant

(http://www.sun.com/bigadmin/features/articles/install_assista
nt.jsp)
Chapter 1 Assisted OS Installation With Sun Installation Assistant (SIA) 5
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CHAPTER 2

Getting Started

This chapter describes how to get started installing the Microsoft Windows Server
2008 SP 2 or the Microsoft Windows Server 2008 R2 operating system manually on
your server module.

Note – The term “manually” refers to performing the installation by following the
instructions provided in Chapters 2 through 4 of this guide, and not using the Sun
Installation Assistant (SIA). If you prefer to perform an assisted Windows
installation by using SIA, see Chapter 1 of this guide.

Topics discussed in this chapter include:

■ “Supported Windows Server Operating Systems” on page 8

■ “Windows Installation Prerequisites” on page 9

■ “Windows Server Installation Task Overview” on page 10

■ “SAS HBAs Requiring LSI Mass Storage Driver for Windows Server 2008 SP2” on
page 11
7



Supported Windows Server Operating
Systems
The Sun Netra X6270 M2 server module supports the following Microsoft Windows
operating systems.

For a complete and updated list of all the supported operating systems on the server
module, see the following web site:

(http://www.oracle.com/goto/netrax6270m2)

Windows OS Edition

• Windows Server 2008 SP2 • Standard Edition (64-bit)
• Enterprise Edition (64-bit)
• Datacenter edition (64-bit)

• Windows Server 2008 R2 • Standard Edition (64-bit)
• Enterprise Edition (64-bit)
• Datacenter edition (64-bit)
8 Sun Netra X6270 M2 Server Module Installation Guide for Windows Operating Systems • October 2010



Windows Installation Prerequisites
Refer to the following important prerequisites before beginning the Windows Server
2008 operating system installation on your server module.

TABLE 2-1 Windows Installation Prerequisites

Requirement Description For more information, see:

Established
deployment method
that enables you to
boot the Windows
install program

Guidelines for selecting a local or remote deployment
method for installing a Windows operating system.

• Appendix A

RAID volume creation If you are using the LSI mass storage controller and you
want to include your boot drive as part of a RAID
configuration, you need to configure a RAID volume on
it. Use the LSI integrated RAID controller setup utility
before you install Windows.

• LSI MegaRAID Software
SAS User’s Guide at:
(http://www.lsi.co
m/support/sun/)

Verification of BIOS
settings for new OS
installations

Prior to installing the Windows Server 2008 operating
system, you should verify that the BIOS factory-default
properties are set.

• Appendix C

Installation of
server-specific device
drivers and optional
supplemental software

After performing the Windows Server 2008 installation,
you might need to:
• Install server module-specific device drivers to support

additional hardware.
Note the Windows 2008 SP2 does not include the LSI
mass storage drivers for the SAS host bus adapters
(HBAs). If you have a SAS HBA option installed, the
LSI mass storage driver for the SAS HBA option must
be made accessible from the Tools and Drivers DVD
during installation. For a list of supported SAS HBAs,
see TABLE 2-2

• Install Windows Server optional supplemental software
that is available for your server module.

• Chapter 4
• “SAS HBAs Requiring

LSI Mass Storage
Driver for Windows
Server 2008 SP2” on
page 11

Incorporate
server-specific device
drivers in a WIM
image

Advanced users can incorporate the post installation
system device drivers into WDS boot and install images.

• Appendix E

Access to
late-breaking
information and
patches for OS
installations

Review the product notes for late-breaking information
about supported operating system software and patches.

• Sun Netra X6270 M2
Server Module Product
Notes, 821-0936
Chapter 2 Getting Started 9



Windows Server Installation Task
Overview
To manually install Windows Server 2008 (SP2 or R2), complete the following
procedures in order:

1. Obtain the Tools and Driver DVD provided or download the latest drivers and
utilities available for your server module as described in Appendix D.

The install program for the Windows Server 2008 SP2 does not include the LSI
drivers for the Sun Storage SAS HBA options. Therefore, if you have a SAS HBA
configured on your server module and you are installing Windows 2008 SP2, the
LSI mass storage driver for the SAS HBA option must be made accessible from
the Tools and Drivers DVD during the installation process.

For a list of SAS HBAs supported on the server module, see “SAS HBAs
Requiring LSI Mass Storage Driver for Windows Server 2008 SP2” on page 11.

Note – Optionally, advanced users might prefer to incorporate the drivers into WDS
images. For instructions on how to incorporate the drivers into WDS images, see
Appendix E.

2. Choose and set up an installation method for deploying the Windows Server
installation as described in Appendix A.

3. Follow the instructions for performing a manual installation of the Windows
Server operating system as described in Chapter 3.

4. Follow the instructions for performing the Windows Server post installation tasks
as described in Chapter 4.
10 Sun Netra X6270 M2 Server Module Installation Guide for Windows Operating Systems • October 2010



SAS HBAs Requiring LSI Mass Storage
Driver for Windows Server 2008 SP2
TABLE 2-2 identifies the SAS host bus adapter options that are supported on the
server module at the time of this publication. If you have one of these SAS HBA
options configured on your server module and you are installing Windows Server
2008 SP2, you will need to load the LSI mass storage driver for the HBA option from
the Tools and Drivers DVD during installation.

Instructions for loading the LSI mass storage driver during the Windows Server 2008
SP2 installation are provided in Step 8 of the “Install Windows Server 2008 (SP2 or
R2) Using Local or Remote Media” on page 14.

If you do not have a copy of the Tools and Drivers DVD, you can download the ISO
image for the Tools and Driver DVD. For details, see Appendix D.

For an up-to-date list of options supported on the server module, see:

(http://www.oracle.com/goto/netrax6270m2)

TABLE 2-2 Supported SAS HBAs Requiring LSI Mass Storage Driver

Supported SAS HBAs Option Number Driver Required During Installation

Sun Storage 6 Gb SAS REM RAID
HBA

SG-SAS6-R-REM-Z
SGX-SAS6-R-REM-Z

LSI MegaRAID SAS 92xx-xx

Sun Storage 6 Gb SAS REM HBA SG-SAS6-REM-Z
SGX-SAS6-REM-Z

LSI MegaRAID SAS 92xx-xx

Sun Storage 6 Gb SAS
ExpressModule RAID HBA

SGX-SAS6-R-EM-Z LSI Adapter SAS 2008 Falcon

Sun Storage 6 Gb SAS
ExpressModule HBA

SGX-SAS6-EM-Z LSI Adapter SAS 2008 Falcon
Chapter 2 Getting Started 11
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CHAPTER 3

Installing Windows Server 2008

This chapter provides information about manually installing the Windows Server
2008 SP2 or Windows Server 2008 R2 operating system.

Note – The term “manually” refers to performing the installation by following the
instructions provided in Chapters 2 through 4 of this guide, and not using the Sun
Installation Assistant (SIA). If you prefer to perform an assisted Windows
installation by using SIA, see Chapter 1 of this guide for details.

This chapter includes the following topics:

■ “Before You Begin” on page 13

■ “Installing Windows Server Using Local or Remote Media” on page 14

■ “Windows Server Installation Using a PXE Network Boot” on page 24

Before You Begin
Ensure that the following requirements are met before you proceed with the
instructions in this chapter for manually installing the Windows Server operating
system.

■ All applicable installation prerequisites for installing an operating system should
have been met. For further information about these prerequisites, see “Windows
Installation Prerequisites” on page 9.

■ An installation method (for example: console output, boot media, and install
target) should have been chosen and established prior to performing the
installation. For more information about these setup requirements, see Appendix
A.
13



■ Use the Microsoft Windows Server 2008 (SP2 or R2) operating system
documentation in conjunction with the Windows Server operating system
instructions provided in this chapter. You can obtain a copy of Microsoft’s
Windows Server 2008 installation documentation at:
(http://www.microsoft.com/windowsserver2008/en/us/product-docu
mentation.aspx)

After completing this procedure, you should review and perform the required post
installation tasks described later in this guide. For more details, see Chapter 4.

Installing Windows Server Using Local
or Remote Media
The procedures in this section describe how to boot the Windows Server 2008 (SP2
or R2) operating system from local or remote media. It assumes that you are booting
the Windows installation media from one of the following sources:

■ Windows Server 2008 SP2 or Windows Server 2008 R2 (or subsequent release) CD
or DVD

■ Windows Server 2008 SP2 or Windows Server 2008 R2 (or subsequent release) ISO
image

Note – The Windows Server 2008 (SP 2 or R2) ISO image can be used for remote
installation or for creating an installation CD or DVD.

Note – If you are booting the installation media from a PXE environment, refer to
“Windows Server Installation Using a PXE Network Boot” on page 24 for
instructions.

▼ Install Windows Server 2008 (SP2 or R2) Using
Local or Remote Media
1. Ensure that the installation media is available to boot.

■ For Distribution CD/DVD. Insert the Windows 2008 Distribution media (CD
labeled number 1 or the single DVD) into the local or remote USB
CD/DVD-ROM drive.
14 Sun Netra X6270 M2 Server Module Installation Guide for Windows Operating Systems • October 2010



■ For ISO image. Ensure that the ISO images are available and that the ILOM
Remote Console application is aware of the first ISO image location.

■ For additional information about how to set up the installation media, see
TABLE A-2.

2. Reset or power on the server module.

For example:

■ From the ILOM web interface, select Remote Control --> Remote Power
Control tab, then select Reset option from the Select Action list box.

■ From the local server module, press the Power button on the front panel of the
server module to power off the server module, then press the Power button
again to power on the server module.

■ From the ILOM CLI, type: reset /SYS

■ From the ILOM CLI on a CMM, type: reset /CH/BLn/SYS

Where n is the number of the server module in the chassis.

The BIOS screen appears.

Note – The next events occur very quickly; therefore, focused attention is needed
for the following steps. Watch carefully for these messages as they appear on the
screen for a brief time. You might want to enlarge the size of your screen to eliminate
scroll bars.

3. In the BIOS power-on self-test screen, press F8 to specify a temporary boot
device for the Windows installation.

The Please Select Boot Device dialog appears.

Note – The dialog that appears in your installation might differ depending on the
type of disk controller installed in your server module.
Chapter 3 Installing Windows Server 2008 15



4. In the Please Select Boot Device dialog, select the menu item according to the
Windows media installation method you elected to use, then press Enter.

For example:

■ If you elected to use the Windows local delivery method, select TEAC as the
physical DVD device (or select CD/DVD if this option is shown in boot device
dialog).

■ If you elected to use the ILOM Remote Console delivery method, select
Virtual CDROM.

5. When prompted with Press any key to boot from CD, press any key.

The Windows installation wizard starts.

Continue the Windows installation wizard until the Installation Type dialog
appears.
16 Sun Netra X6270 M2 Server Module Installation Guide for Windows Operating Systems • October 2010



6. In the Installation Type dialog, click Custom (advanced).

The Where Do You Want to Install Windows dialog appears.
Chapter 3 Installing Windows Server 2008 17



7. In the Where Do You Want to Install Windows dialog, perform one of the
following tasks in the table below to specify a storage target for the Windows
Server operating system edition.

8. (Load HBA Storage Driver) In the Load Drive dialog, do the following:

For Windows Server Edition Task

Windows Server 2008 SP2
(or subsequent Windows 2008
SP release)

Perform one of the following:
• If you do not see any storage targets listed and have

a Sun Storage SAS RAID HBA option configured on
your server, click Load Driver then proceed to Step
8.
- or -

• If you see the storage target where you want to
install the operating system but want to change the
default partition settings associated with that target,
select the target, click Drive Options, then proceed
to Step 9.
- or -

• If you see the storage target where you want to
install the operating system and do not want to
change the default partition settings for that target,
select the target and click Next, then proceed to
Step 10.

Windows Server 2008 R2
(or subsequent Windows 2008
R2 release)

Perform one of the following:
• If you see the storage target where you want to

install the operating system but want to change the
default partition settings associated with that target,
select the target, click Drive Options, then proceed
to Step 9.
- or -

• If you see the storage target where you want to
install the operating system and do not want to
change the default partition settings for that target,
select the target and click Next, then proceed to
Step 10.
18 Sun Netra X6270 M2 Server Module Installation Guide for Windows Operating Systems • October 2010



a. Ensure the storage driver(s) are accessible according to the installation
method chosen (described in Appendix A).

For example:

■ Floppy Disk Local. Storage driver(s) on a floppy disk in floppy drive A on
the server.

■ Floppy Disk Remote. Storage driver(s) on a floppy disk in a floppy drive
mounted as a device from the ILOM Remote Console.

■ Floppy Image. Storage driver floppy.img file is mounted as a device from
the ILOM Remote Console.

■ Non-floppy Media. Storage driver(s) are on a local physical storage media
(USB flash drive or CD/DVD) or virtual media mounted from the ILOM
Remote Console.

b. In the Load Driver dialog, click Browse to navigate to the appropriate driver
media folder as described below.

■ For systems configured with either of these SAS RAID HBA options—
SG-SAS6-R-REM-Z/SGX-SAS6-R-REM-Z, or
SG-SAS6-R-EM-Z/SGX-SAS6-R-EM-Z—navigate to the following directory
on the Tools and Drivers DVD to load the appropriate LSI driver:
windows/w2k8/drivers/64bit/hba/lsi/megaraid
Chapter 3 Installing Windows Server 2008 19



■ For a system configured with either of these SAS HBA options—
SG-SAS6-REM-Z/SGX-SAS6-REM-Z, or
SG-SAS6-EM-Z/SGX-SAS6-EM-Z—navigate to the following directory on
the Tools and Driver DVD to load the appropriate LSI driver:
windows/w2k8/drivers/64bit/hba/lsi/mpt2

c. In the Browse for Folder dialog, select the appropriate driver, then click OK
to load the driver.

The selected driver appears in the Select the Driver to Be Installed dialog.
Example dialogs follow showing a selected mass storage driver for a SAS HBA.
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d. In the Select the Driver to Be Installed dialog, click Next to install the
driver.

The Where Do You Want to Install Windows dialog appears.

e. In the Where Do You Want to Install Windows dialog, do one of following:

■ Select the storage target listed and click Next to install the operating
system, then proceed to Step 10.

- or -

■ Select the storage target listed and click Drive Options (Advanced) to
view and change the default partition settings, then proceed to Step 9.

The partition settings for the selected target appear at the bottom of the
Where Do You Want to Install Windows dialog.

9. (Partition Drive, advanced) In the lower portion of the Where Do You Want to
Install Windows dialog, do the following:
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a. Click Delete to delete the selected storage target existing partition
configuration.

A confirmation window appears.

b. Click OK to confirm the partition deletion.

c. Click New to create a new partition on the selected storage target.

d. In the Size scroll box, increase or decrease the partition size as needed, then
click Apply.

The partition is created.

e. Click Next to install the operating system to the selected storage target.

10. The Windows installation program begins and will reboot the server module
multiple times during the installation process.

11. When the Windows installation is complete, Windows starts and prompts you
to change the user password.

12. In the user password dialog, click OK and set up the initial user login account.
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Note – Windows Server 2008 enforces stronger password schemes for user accounts.
Password standards include restrictions on length, complexity, and history. For more
details, click the Accessibility link at the account creation page.

After the initial user account is created, the Windows Server 2008 desktop
appears.

13. Proceed to Chapter 4 to perform the post installation tasks.

Windows Server Installation Using a
PXE Network Boot
This section explains the initial information you will need to install the Windows
Server 2008 (SP2 or R2) operating system over an established PXE-based network
using a customer-provided Windows Imaging Format (WIM) image.

Topics included in this section:

■ “Before You Begin” on page 24

■ “Install Windows Server 2008 (SP2 or R2) Using PXE” on page 25

Note that the procedure presented in this section documents the initial steps to
install Windows Server 2008 over the network using a Windows Deployment
Services (WDS). Specifically, it explains the steps for selecting the server PXE
network interface card that will communicate with your WDS installation server. For
further information about using WDS to install the Windows Server 2008 operating
system, see Microsoft’s Windows Deployment Services documentation.

Before You Begin
■ To use PXE to boot the installation media over the network, you must:

■ Configure the network (NFS, FTP, HTTP) server to export the installation tree.

■ Configure the files on the TFTP server that are necessary for PXE booting.

■ Configure the server’s MAC network port address to boot from the PXE
configuration.

■ Configure Dynamic Host Configuration Protocol (DHCP).

■ To use WDS to perform the installation, you must:

■ Add the required system device drivers to the install.wim image and, if
necessary, the boot.wim image.
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For guidelines for adding drivers to the WIM installation image(s), see
Appendix E.

■ Obtain the WIM Administrator password.

▼ Install Windows Server 2008 (SP2 or R2) Using PXE
1. Reset or power on the server module.

■ From the ILOM web interface, select Remote Power --> Remote Power
Control tab, then select Reset from the Select Action list box.

■ From the local server module, press the Power button on the front panel of the
server module to turn off the server module, then press the Power button again
to power on the server module.

■ From the ILOM CLI, type: reset /SYS

■ From the ILOM CLI on a CMM, type: reset /CH/BLn/SYS

■ Where n is the number of server module in the chassis.

The BIOS screen appears.

Note – The next events occur very quickly; therefore, focused attention is needed
for the following steps. Watch carefully for these messages as they appear on the
screen for a brief time. You might want to enlarge the size of your screen to eliminate
scroll bars.

2. Press F8 to specify a temporary boot device.

The Please Select Boot Device menu appears.

3. In the Please Select Boot Device menu, select the appropriate PXE installation
boot device and press Enter.

Note that the PXE installation boot device is the physical network port configured
to communicate with your network installation server.

The Boot Agent dialog appears.

4. In the Boot Agent dialog, press F12 for a network service boot.

5. Continue the normal Windows Server 2008 SP2 or 2008 R2 WDS network
installation.

For additional information, consult Microsoft’s Windows Deployment Services
product documentation.

6. When the installation completes, proceed to Chapter 4 to perform the post
installation tasks.
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CHAPTER 4

Post Installation of Windows Server
2008

After completing the installation of the Windows Server 2008 (SP2 or R2) operating
system and rebooting the server module, you should review the following post
installation tasks and, if necessary, perform the tasks that are applicable to your
server module.

■ “Installing Critical Device Drivers and Supplemental Software” on page 28

■ “Installing Supplemental Software” on page 29

■ “Configuring Support for TPM” on page 31

■ “Configuring Intel NIC Teaming” on page 31

Before You Begin
The procedures in this chapter assume that you have:

■ Installed the Microsoft Windows Server operating system

■ Obtained a copy of the Tools and Drivers DVD.

If you do not have a copy of the Tools and Drivers DVD, you can download the
latest ISO image of the Tools and Drivers DVD from the product download site.
For Instructions see, Appendix D.
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Installing Critical Device Drivers and
Supplemental Software
An installation wizard is provided on the Tools and Drivers DVD to install server
module-specific device drivers and Supplemental Software. The server
module-specific device drivers are provided to support optional hardware devices
that can be installed on your server module.

▼ Install Server Module-Specific Device Drivers
1. Insert the Tools and Drivers DVD into a local or remote USB DVD drive and do

one of the following:

■ If the DVD automatically starts, click Install Drivers and Supplement
Software.

■ If the DVD does not automatically start, navigate to one of the following
folders containing the appropriate InstallPack file (for example,
InstallPack_1_0_1.exe), and double-click it.

■ <DVD>/Windows/W2K8/Packages

■ <DVD>/Windows/W2K8R2/Packages

The Server Installation Package dialog appears.

2. In the Install Pack dialog, click Next to accept the default installable items.

Note – You should always accept the “default installable items” to ensure that the
most recent versions of the drivers are installed.

The Install Pack notice dialog appears.

3. In the Install Pack notice dialog, read the message, then click Next.

The Welcome to the Sun Fire Installation Wizard appears.

4. In the Welcome to the Sun Fire Installation Wizard dialog, click Next.

The End User License Agreement page appears.

5. In the End User License Agreement page, select I Accept This Agreement,
then click Next.

The platform-specific drivers are installed. A green check mark verifies that each
driver was installed successfully.
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6. In the Driver Installation Pack dialog, click Finish.

The System Settings Change dialog appears.

Note – If you plan on installing Supplemental Software (highly recommended), do
not restart your system at this time. Once the Supplemental Software has been
installed, you will be prompted to restart the system.

7. Perform one of the following:

■ If you accepted the default installable settings in Step 2, click No to proceed
to “Installing Supplemental Software” on page 29.

■ If you are not installing the Supplemental Software, click Yes to restart your
computer.

Installing Supplemental Software
There are several Supplemental Software components available for your server
module. You have two options for installation:

■ Typical: Installs all Supplemental Software applicable for your server module.

■ Custom: Installs only the Supplement Software selected for installation.
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TABLE 4-1 identifies the optional Supplemental Software components available for
your server module.

▼ Install the Supplemental Software

Caution – If you have already installed the Supplemental Software, running the
installation again will not necessarily reinstall the Supplemental Software. It might
result in the components being removed. Carefully review the dialog boxes during
Supplemental Software installation to ensure that the results are as expected.

1. Do one of the following:

■ If you did not select the Supplemental Software when you ran the procedure
“Installing Critical Device Drivers and Supplemental Software” on page 28,
refer back to that procedure and run it again, but this time accept the default
settings in Step 2 (the default is to install the Supplemental Software), and
select No in Step 7.

■ If you did select Supplemental Software at the Server Installation Package
dialog box in Step 2 of “Installing Critical Device Drivers and Supplemental
Software” on page 28, and selected No in Step 7, the Install Pack Supplemental
Software dialog appears. Proceed to Step 2.

TABLE 4-1 Install Pack Optional Supplemental Software

Available Supplemental Software Components

Server modules
With LSI Integrated

RAID Controller

Server modules With
Intel Integrated Disk

Controller

LSI MEGARAID Storage Manager, click Yes to restart your
computer
Enables you to configure, monitor, and maintain RAID on the SAS
internal RAID host bus adapter (HBA).

Typical Not applicable

IPMItool command-line utility
The IMPItool command-line utility reads the sensor data repository
(SDR) and displays sensor values, system event log (SEL), and field-
replaceable unit (FRU) inventory information; gets and sets LAN
configuration parameters; and performs chassis power control
operations via the BMC (also called the service processor (SP).

Typical Typical

Intel NIC Teaming
Enables the network interfaces on a server module to be grouped
together into a team of physical ports called a virtual interface.

Typical Typical
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2. In the Install Pack Supplement Software dialog, click Next to accept the typical
settings; or select Custom to choose the options to install (see descriptions of
the Supplemental Software in TABLE 4-1).

The Component Installation wizard will guide you through the installation of
each of the selected Supplemental Software components.

3. After the Supplemental Software has been installed, click Finish.

4. Click Yes at the System Setting Change dialog to restart your system.

If you ran the Sun Server Installation Package software from the Tools and
Drivers DVD, remove the DVD from your system.

Configuring Support for TPM
If you intend to use the Trusted Platform Module (TPM) feature set that is provided
in Windows 2008, you must configure the server module to support this feature. For
instructions, see the configuring support for TPM information in the Sun Netra
X6270 M2 Server Module Service Manual, 821-0939.

Note – TPM enables you to administer the TPM security hardware in your server
module. For additional information about implementing this feature, refer to the
Windows Trusted Platform Module Management documentation provided by
Microsoft.

Configuring Intel NIC Teaming
For more information on setting up NIC teaming for your environment, refer to the
Intel Connectivity web page on Advanced Networking Services Teaming at:

(http://support.intel.com/support/network/sb/CS-009747.htm)

Additionally, you can download the complete set of Intel Network Connections User
Guides for your server module’s network adapters at:

(http://support.intel.com/support/network/sb/cs-009715.htm)
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PART II Windows Server System Administrator
References

Refer to the following system administrator references as needed to perform or
complete the installation of the Windows Server 2008 (SP2 or R2) operating system.

Description Link

Guidelines for selecting and setting up an installation
environment for deploying the Windows Server installation
program

Appendix A

A complete list of operating systems supported on the Sun
Netra X6270 M2 server module at the time of this publication

Appendix B

Instructions for ensuring that the BIOS default properties are
set prior to performing the Windows Server installation

Appendix C

Instructions for downloading the latest version of the ISO
image for the Tools and Drivers DVD

Appendix D

Instructions for advanced users who prefer to incorporate the
server module-specific drivers in a Windows Imaging Format
(WIM) file

Appendix E

Guidelines for determining your server module active
network ports and matching them to Windows device names.

Appendix F





APPENDIX A

Supported Installation Methods

To determine which installation method is best for you when installing Windows on
your server module, consider the following options summarized in this appendix:

■ “Console Outputs” on page 36

■ “Installation Boot Media” on page 38

■ “Installation Targets” on page 41
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Console Outputs
TABLE A-1 lists the consoles you can use to capture the output and input of the
operating system installation.

TABLE A-1 Console Options for Performing an OS Installation

Console Description Setup Requirement

Local console You can install the OS and
administer the server module by
attaching a local console directly
to the server module SP.
Examples of local consoles
include:
• Serial console
• VGA console, with USB

keyboard and mouse

1. Attach a local console to the server module.
For details, see “Attaching Devices to the Server
Module” in the Sun Netra X6270 M2 Server Module
Installation Guide, 821-0937, and Appendix C in the
Sun Netra X6270 M2 Server Module
Service Manual, 821-0939.

2. At the ILOM prompt, type your ILOM user name and
password.

3. For serial console connections only, establish a
connection to the host serial port by typing start
/SP/console.
The video output is automatically routed to the local
console.

For further details about establishing a connection to the
server module SP, see the Oracle Integrated Lights Out
Manager (ILOM) 3.0 Concepts Guide, 820-6410.
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Remote console You can install the OS and
administer the server module
from a remote console by
establishing a network
connection to the server module
SP.
Examples of remote consoles
include:
• Web-based client connection

using the ILOM Remote
Console application

• SSH client connection using a
serial console

1. View or establish an IP address for the server module
SP.
For details, see the Sun Netra X6270 M2 Server Module
Installation Guide, 821-0937.

2. View or establish a connection between a remote
console and the server module SP:

• For web-based client connection, perform these steps:
1) In a web browser, type the IP address for the server
module SP; 2) log in to the ILOM web interface; 3)
redirect the video output from the server module to
the web client by launching the ILOM Remote
Console; 4) enable device redirection (mouse,
keyboard, etc.) in the Device menu.

• For SSH client connection, perform these steps:
1) From a serial console, establish an SSH connection
to the server module SP (ssh root@ipaddress); 2) log in
to ILOM; 3) redirect the serial output from the server
module to the SSH client by typing start
/SP/console.

For additional information about establishing a remote
connection to the ILOM SP or using the ILOM Remote
Console, see the Oracle Integrated Lights Out
Manager (ILOM) 3.0 Concepts Guide,
820-6410).

TABLE A-1 Console Options for Performing an OS Installation (Continued)

Console Description Setup Requirement
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Installation Boot Media
You can start the operating system installation to a server module by booting a local
or remote installation media source. TABLE A-2 identifies the supported media
sources and the setup requirements for each source.

TABLE A-2 Boot Media Options for Performing an OS Installation

Installation Media Description Setup Requirement

Local boot media Local boot media requires a built-in
storage device on the server
module, or an external storage
device attached to the server
module.
Supported OS local boot media
sources can include:
• CD/DVD-ROM installation

media, and, if applicable, floppy
device driver media

1. If your server module does not contain a built-in
storage device, attach the appropriate storage device
to the front panel using the dongle cable.

2. For more information about how to attach local
devices to the server module, see “Attaching
Devices to the Server Module” in the Sun Netra
X6270 M2 Server Module Installation Guide, 821-0937,
and Appendix C in the Sun Netra X6270 M2 Server
Module Service Manual, 821-0939.
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Remote boot
media

Remote media requires you to boot
the install over the network. You
can start the network install from a
redirected boot storage device or
another networked system that
exports the installation over the
network using a Pre-Boot eXecution
environment (PXE).

To redirect the boot media from a remote storage
device, perform these steps:
1. Insert the boot media into the storage device, for

example:
For CD/DVD-ROM, insert media into the built-in or
external CD/DVD-ROM drive.
For CD/DVD-ROM ISO image, ensure that ISO
image(s) are readily available on a network shared
location.
For device driver floppy ISO image, ensure that ISO
image, if applicable, is readily available on a
network shared location or on a USB drive.
For device driver floppy media, if applicable, insert
floppy media into the external floppy drive.

2. Establish a web-based client connection to the server
module ILOM SP and launch the ILOM Remote
Console application. For more details, see the Setup
Requirements for web-based client connection in
TABLE A-1.

3. In the Device menu of the ILOM Remote Console
application, specify the location of the boot media,
for example:
For CD/DVD-ROM boot media, select CD-ROM.
For CD/DVD-ROM ISO image boot media, select
CD-ROM Image.
For floppy device driver boot media, if applicable,
select Floppy.
For floppy image device driver boot media, if
applicable, select Floppy Image.

For more information about the ILOM Remote
Console, see the Oracle Integrated Lights Out Manager
(ILOM) 3.0 Concepts Guide, 820-6410.

Supported OS remote media sources
can include:
• CD/DVD-ROM installation

media, and, if applicable, floppy
device driver media

• CD/DVD-ROM ISO installation
image and, if applicable, floppy
ISO device driver media

• Automated installation image
(requires PXE boot)

TABLE A-2 Boot Media Options for Performing an OS Installation (Continued)

Installation Media Description Setup Requirement
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Remote Boot
Media
(continued)

Note - An automated installation
image enables you to perform the
OS installation on multiple servers.
By using an automated image, you
can ensure configuration uniformity
among many systems.

Automated installations use a
Pre-boot eXecution Environment
(PXE) technology to enable the
clients without an operating system
to boot remotely to the automated
install server that performs the
installation of the operating system.

To perform the installation using PXE, perform these
steps:
1. Configure the network server to export the

installation via PXE boot.
2. Make the OS install media available for PXE boot.

If you are using an automated OS installation image,
you will need to create and provide the automated
OS install image, for example:
— Oracle Solaris JumpStart Image
— RHEL KickStart Image
— SLES AutoYaST Image
— Windows WDS Image
For detailed instructions for automating the
installation setup process, consult the operating
system vendor documentation.

3. To boot the installation media, select the PXE boot
interface card as the temporary boot device.
For details, see “Windows Server Installation Using
a PXE Network Boot” on page 24.

TABLE A-2 Boot Media Options for Performing an OS Installation (Continued)

Installation Media Description Setup Requirement
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Installation Targets
TABLE A-3 identifies the supported installation targets you can use to install an
operating system.

TABLE A-3 Installation Targets for OS Installation

Install Target Description Setup Requirement Supported OS

Local hard disk
drive (HDD)
or
Solid state drive
(SSD)

You can choose to install the
operating system to any of the
hard drives or solid state drives
installed in the server.

• Ensure that the HDD or SSD is
properly installed and powered-on in
the server module.

For more information about installing
and powering on an HDD or SDD, refer
to the Sun Netra X6270 M2 Server Module
Service Manual, 821-0939.

• All supported
operating
systems listed
in Appendix
B.

Fibre Channel
(FC) Storage
Area Network
(SAN) device

For server modules equipped
with Fibre Channel Host Bus
Adapters (HBAs), you can
choose to install the operating
system to an external FC storage
device.

• Ensure FC HBA is properly installed
in the server module.

For more information about installing a
HBA option in your server module, refer
to the Sun Netra X6270 M2 Server Module
Service Manual, 821-0939.
• The SAN must be installed and

configured to make the storage visible
to the host.
For instructions, refer to the
documentation supplied with the FC
HBA.

• All operating
systems listed
in Appendix
B.
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APPENDIX B

Supported Operating Systems

TABLE B-1 in this appendix describes the operating systems supported on the Sun
Netra X6270 M2 server module at the time this document was published.

For an up-to-date list of the latest operating systems supported on the server
module, see the following web site:

(http://www.oracle.com/goto/netrax6270m2)
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Supported Operating Systems
The Sun Netra X6270 M2 server module supports the installation and use of the
following operating systems, or a subsequent release of the operating system.

TABLE B-1 Supported Operating Systems

Operating System Supported Version Additional Information

Windows • Microsoft Windows Server 2008 SP2, Standard
Edition (64-bit)

• Microsoft Windows Server 2008 SP2,
Enterprise Edition (64-bit)

• Microsoft Windows Server 2008 SP2,
Datacenter Edition (64-bit)

• Microsoft Windows Server 2008 R2, Standard
Edition (64-bit)

• Microsoft Windows Server 2008 R2, Enterprise
Edition (64-bit)

• Microsoft Windows Server 2008 R2, Datacenter
Edition (64-bit)

• Chapter 3

Linux, Oracle
Solaris, Virtual
Machine
Software

• Oracle Enterprise Linux (OEL) 5.4 (64-bit)
• SUSE Linux Enterprise Server (SLES) 10 SP 3

(64-bit)
• SUSE Linux Enterprise Server (SLES) 11

(64-bit)
• Red Hat Enterprise Linux Server (RHEL) 5.4

(64-bit)
• Oracle Solaris 10 10/09
• Oracle VM 2.2.1
• VMware ESX and ESXi 4.0 Update 1

• Sun Netra X6270
M2 Server Module
Installation Guide
for Linux, Virtual
Machine Software,
and Oracle Solaris
Operating Systems,
821-0940
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APPENDIX C

BIOS Defaults for New Installations

When installing a new operating system on a disk drive, you should verify that the
following BIOS settings are properly configured before you perform the operating
system installation:

■ System time

■ System date

■ Boot order

Verification of BIOS Factory Defaults
In the BIOS Setup Utility, you can set optimal defaults, as well as view and edit BIOS
settings as needed. Any changes you make in the BIOS Setup Utility (by pressing F2)
are permanent until the next time you change them.

In addition to using the F2 key to view or edit the system’s BIOS settings, you can
use F8 during the BIOS start-up to specify a temporary boot device. If you use F8 to
set a temporary boot device, this change is only in effect for the current system boot.
The permanent boot device specified through F2 will be in effect after booting from
the temporary boot device.

Before You Begin
Ensure that the following requirements are met prior to accessing the BIOS Setup
Utility.

■ The server module is equipped with a hard disk drive (HDD) or solid state disk
drive (SDD).
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■ The HDD or SDD is properly installed in the server module. For details, see the
Sun Netra X6270 M2 Server Module Service Manual, 821-0939.

■ A console connection is established to the server module. For details, see
“Console Options for Performing an OS Installation” on page 36.

▼ View or Edit BIOS Settings for New Installations
1. Reset the power on the server module.

For example:

■ From the ILOM web interface, select Remote Control --> Remote Power
Control tab, then select Reset option from the Select Action list box.

■ From the local server module, press the Power button on the front panel of the
server module to power off the server module, then press the Power button
again to power on the server module.

■ From the ILOM CLI, type: reset /SYS

■ From the ILOM CLI on a CMM, type: reset /CH/BLn/SYS

Where n is the number of server module in chassis.

2. When prompted in the BIOS screen, press F2 to access the BIOS Setup Utility.

After a few moments, the BIOS Setup Utility appears.

3. To ensure that the factory defaults are set, do the following:

a. Press F9 to automatically load the optimal factory default settings.

A message appears prompting you to continue this operation by selecting OK
or to cancel this operation by selecting CANCEL.

b. In the message, highlight OK then press Enter.

The BIOS Setup Utility screen appears with the cursor highlighting the first
value in the system time field.

4. In the BIOS Setup Utility, do the following to edit the values associated with
the system time or date.

a. Highlight the values you want to change.

Use up or down arrow keys to change between the system time and date
selection

b. To change the values in the highlighted fields, use these keys:

■ PLUS (+) to increment the current value shown

■ MINUS (-) to decrement the current value shown

■ ENTER to move the cursor to the next value field
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5. To access the boot settings, select the Boot menu.

The Boot Settings menu appears.

6. In the Boot Settings menu, use the down arrow key to select Boot Device
Priority, then press Enter.

The Boot Device Priority menu appears listing the order of the known bootable
devices. The first device in the list has the highest boot priority.

7. In the Boot Device Priority menu, do the following to edit the first boot device
entry in the list:

a. Use the up and down arrow keys to select the first entry in the list, then
press Enter.

b. In the Options menu, use the up and down arrow keys to select the default
permanent boot device, then press Enter.

Note – You can change the boot order for other devices in the list by repeating Steps
7a and 7b for each device entry you want to change.

The device strings listed on the Boot Device Priority menu and Options menu are
in the format of: device type, slot indicator, and product ID string.

8. To save changes and exit the BIOS Setup Utility, press F10.

Alternatively, you can save the changes and exit the BIOS Setup Utility by
selecting Save on the Exit menu. A message appears prompting you to save
changes and exit setup.

In the message dialog, select OK, then press Enter.

Note – When using the ILOM Remote Console, F10 is trapped by the local OS. You
must use the F10 option listed in the Keyboard drop-down menu that is available at
the top of the console.
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APPENDIX D

Downloading the ISO Image for the
Tools and Drivers DVD

Use the download instructions in this appendix if a Tools and Driver DVD was not
shipped with your server module or, if you need to verify that the Tools and Drivers
DVD shipped with your server module contains the latest tools and firmware for
your server module.

ISO Image Download Procedure
Follow the steps in the procedure below to download the ISO image for the Tools
and Drivers DVD.

▼ Download the Tools and Drivers DVD Image
1. Go to Oracle’s Sun Netra X6270 M2 server module web site and navigate to the

Tools and Driver DVD download link:

(http://www.oracle.com/goto/netrax6270m2)

2. Select and download the ISO image for the Tools and Drivers DVD to an
accessible network location or local storage location.

3. Prepare the ISO image for installation by using one of the following methods:

■ Create a Tools and Drivers DVD using third-party software.

■ Use remote KVMS (ILOM Remote Console) to mount the ISO image.
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APPENDIX E

Incorporating Device Drivers Into
Windows Server 2008 WIM Images
for Windows Deployment Services

This section is for advanced system administrators who need to incorporate
Windows Server 2008 (SP2 or R2) device drivers into Windows Imaging Format
(WIM) files.

This appendix assumes that the system administrator is using Microsoft’s Windows
Deployment Services (WDS) to deploy the installation of Windows Server 2008 (SP2
or R2) over a network.

Note – This appendix is not intended as a tutorial for WDS or Microsoft’s Windows
System Imaging Manager (WSIM). For detailed information about WDS or WSIM,
refer to Microsoft’s WDS and WSIM documentation.

Topics in this section include:

■ “Getting Started” on page 52

■ “Location of Device Drivers on Tools and Drivers DVD” on page 52

■ “Which Device Drivers to Incorporate Into WIM Image(s)” on page 53

■ “Prerequisites and Task Overview” on page 54

■ “Procedures for Incorporating Drivers Into WIM Image(s)” on page 57

■ “Create an ImageUnattend.xml Setup Script – Windows Server 2008 (SP2 or
R2)” on page 57

■ “Add Device Driver(s) to Boot WIM – Windows Server 2008 SP2 Only” on
page 62

■ “Map ImageUnattend.xml Setup Script to Windows Server 2008 (SP2 or R2)
Install Image” on page 65
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Getting Started
Topics included in this section include:

■ “Location of Device Drivers on Tools and Drivers DVD” on page 52

■ “Which Device Drivers to Incorporate Into WIM Image(s)” on page 53

■ “Prerequisites and Task Overview” on page 54

Location of Device Drivers on Tools and Drivers
DVD
TABLE E-1 identifies the location of the device driver directories on the Tools and
Drivers DVD.

Note – If you do not have a copy of the Tools and Drivers DVD, you can download
the ISO image for the Tools and Driver DVD. For details, see Appendix D

TABLE E-1 Device Driver Directory Location on Tools and Drivers DVD

Device Drivers Directory Location on Tools and Driver DVD

Intel Network Driver • For Windows 2008 R2:
windows\W2K8R2\drivers\NIC\intel

• For Windows 2008 SP2:
windows\w2K8\drivers\NIC\intel

Aspeed Driver • For Windows 2008 R2:
windows\W2K8R2\drivers\display\
aspeed

• For Windows 2008 SP2:
windows\w2K8\drivers\display\aspeed
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Which Device Drivers to Incorporate Into WIM
Image(s)
TABLE E-2 identifies the device drivers to incorporate in the Windows Server 2008
(SP2 or R2) WIM image(s). Note, the boot WIM image identified in the table is only
required for Windows Server 2008 SP2 installations, and the install WIM image
identified in the table is required for both Windows Server 2008 SP2 and Windows
Server 2008 R2 installations.

LSI MegRAID Driver:
• Sun Storage 6 Gb SAS RAID HBA,

SG-SAS6-R-REM-Z
• Sun Storage 6 Gb SAS RAID HBA,

SGX-SAS6-R-REM-Z
• Sun Storage 6 Gb SAS RAID HBA,

SG-SAS6-R-EM-Z

• windows/w2k8/drivers/64bit/hba/lsi/
megaraid

LSI MPT2 Driver:
• Sun Storage 6 Gb SAS HBA,

SG-SAS6-REM-Z
• Sun Storage 6 Gb SAS HBA,

SGX-SAS6-REM-Z
• Sun Storage 6 Gb SAS HBA,

SG-SAS6-EM-Z

• windows/w2k8/drivers/64bit/hba/lsi/
mpt2

Intel ICH10 Controller • For Windows 2008 R2:
windows\W2K8R2\drivers\64bit\HBA\
intel

• For Windows 2008 SP2:
windows\w2K8\drivers\64bit\HBA\
intel

TABLE E-1 Device Driver Directory Location on Tools and Drivers DVD (Continued)

Device Drivers Directory Location on Tools and Driver DVD
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Some of the SAS PCIe HBA option cards listed in TABLE E-2 might not be available
for purchase at the time of this publication. To determine which SAS PCIe HBA
option cards are supported and available for purchase on the server module, go to
the following web site and navigate to the appropriate page:
(http://www.oracle.com/goto/netrax6270m2).

Prerequisites and Task Overview
Prior to creating the device driver WIM image(s) for Windows Server 2008 (SP2 or
R2), ensure that the following tasks are completed in the order specified.

1. Install and configure the Windows Deployment Services on a server in your
network. For details, you can download Microsoft’s Windows Deployment Services
Step-by-Step Guide at:

(http://www.microsoft.com/downloads/details.aspx?familyid=
14CA18B1-B433-4F62-8586-B0A2096460EB&displaylang=en).

2. Install the Windows Automated Installation Kit (WAIK). The WAIK contains
applications to mount and modify WIM images as well as applications to create
and modify XML unattended setup scripts.

TABLE E-2 Device Drivers to Add to WIM Image(s)

Device Drivers to Incorporate

Windows Server 2008 (SP2
and R2)
Add to install.wim

Windows Server 2008 SP2
Only
Add to boot.wim

Intel Network Drivers X X

Aspeed Graphic Driver X

SAS HBA option installed on server
module:
• Sun Storage 6 Gb SAS RAID HBA,

SG-SAS6-R-REM-Z
• Sun Storage 6 Gb SAS RAID HBA,

SGX-SAS6-R-REM-Z
• Sun Storage 6 Gb SAS RAID HBA,

SG-SAS6-R-EM-Z
• Sun Storage 6 Gb SAS HBA,

SG-SAS6-REM-Z
• Sun Storage 6 Gb SAS HBA,

SGX-SAS6-REM-Z
• Sun Storage 6 Gb SAS HBA,

SG-SAS6-EM-Z

X X

Intel ICH10 Controller X
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Microsoft provides separate WAIK downloads for Windows Server 2008 SP2 and
Windows Server 2008 R2. The URLs for these downloads are as follows:

■ Windows Server 2008 SP2 at:
(http://www.microsoft.com/downloads/details.aspx?displaylang
=en&FamilyID=94bb6e34?d890?4932?81a5?5b50c657de08)

■ Windows Server 2008 R2 at:
(http://www.microsoft.com/downloads/details.aspx?displaylang
=en&FamilyID=696dd665?9f76?4177?a811?39c26d3b3b34)

3. Locate the Windows device drivers on the Tools and Driver DVD. For information
about where the device drivers on the Tools and Drivers DVD are located, see
“Location of Device Drivers on Tools and Drivers DVD” on page 52.

4. Establish a network-shared device driver repository. For example:

■ Create a device driver repository containing the Windows Server 2008 (SP2 or
R2) device drivers.

Note that for Windows Server 2008 WDS installation environments, a device
driver repository is provided, which you can modify. For Windows Server 2003
SP2 WDS installation environments, a device driver repository is not provided
and you must manually create one. The following is an example of how you
might want to set up the directory structure for a new device driver repository:

C:\unattend\drivers\{w2K8|W2k8R2}\catalogs\vendor\version

Where:

– unattend is the unattend device driver store

– drivers is the name for device driver directory

– {W2K8 or W2K8R2} is the name for Windows Server 2008 (SP2 or R2)
device drivers directory

– catalogs is the name for Windows Server 2008 (SP2 or R2) catalog files

– vendor is the name of directory for device driver vendor

– version is the name of directory for device driver version

■ Ensure that the directories (folders) in the device driver repository are shared
and accessible to the Windows Deployment Services (WDS) during the
network installation.

For example, the device driver repository network shares referenced in this
appendix are setup as follows:

Repository Folder Network Shares

C:\Unattended\Drivers\W2K8 \\wds-server\W2K8-Drivers

C:\Unattended\Drivers\W2K8R2 \\wds-server\W2K8R2-Drivers
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■ Extract the Windows Server 2008 device drivers on the Tools and Drivers DVD
and place them into the device driver repository.

For details about where the Windows Server 2008 device drivers are located on
the Tools and Driver DVD, see “Location of Device Drivers on Tools and
Drivers DVD” on page 52.

If you do not have a copy of the Tools and Drivers DVD, you can download the
ISO image for the Tools and Driver DVD. For details, see Appendix D.

The following example demonstrates the directory structure of the device
driver repository after copying a SAS HBA driver (example version number:
1.19.2.64) from the Tools and Drivers DVD to the device driver repository:

5. Create an imageunattend.xml Setup Script for Windows Server 2008 (SP2 or
R2. For details, see “Create an ImageUnattend.xml Setup Script – Windows
Server 2008 (SP2 or R2)” on page 57.

6. For Windows Server 2008 SP2 (only) installations, add the required boot device
drivers described in TABLE E-2 to boot.wim. For details about adding the device
drivers to the boot.wim, see “Add Device Driver(s) to Boot WIM – Windows
Server 2008 SP2 Only” on page 62.

7. Map the imageunattend.xml Setup Script to the Windows Server 2008 image.
For details, see “Map ImageUnattend.xml Setup Script to Windows Server 2008
(SP2 or R2) Install Image” on page 65.

8. For Windows Server 2008 SP2 and Windows Server 2008 R2 installations, add the
required device drivers described in TABLE E-2 to the install.wim image.

Operating System Tools and Driver DVD Device Driver Repository

Windows Server 2008
SP2

DVDDevice:\windows\
W2K8\drivers\64bit\
hba\lsi\mpt2

C:\unattend\drivers\
W2K8\lsi\1.19.2.64

Windows Server 2008 R2 DVDDevice:\windows\
W2K8R2\drivers\64bit\
hba\lsi\mpt2

C:\unattend\drivers\
W2K8R2\lsi\1.19.2.64
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Procedures for Incorporating Drivers
Into WIM Image(s)
The following procedures presented are guidelines you can use to add device
drivers to the WIM image file(s). These procedures should be performed in the order
described.

■ “Create an ImageUnattend.xml Setup Script – Windows Server 2008 (SP2 or
R2)” on page 57

■ “Add Device Driver(s) to Boot WIM – Windows Server 2008 SP2 Only” on
page 62

■ “Map ImageUnattend.xml Setup Script to Windows Server 2008 (SP2 or R2)
Install Image” on page 65

Before you Begin
Prior to performing the procedures in this section, you should ensure that all the
prerequisites as described in “Prerequisites and Task Overview” on page 54 have
been met.

▼ Create an ImageUnattend.xml Setup Script –
Windows Server 2008 (SP2 or R2)
Follow these steps to create an ImageUnattend.xml Setup Script for a Windows
Server 2008 (SP2 or R2) installation. After the setup script is generated, it will be
saved to the device driver repository.

Note – The ImageUnattend.xml Setup Script (in a later procedure described in
this section) will be mapped to a Windows Server 2008 (SP2 or R2) install image.
After the setup script is mapped to the install image, the install image will install the
specified device drivers during the Windows Server 2008 (SP2 or R2) network
installation.

1. Insert the Windows Server 2008 (SP2 or R2) DVD media into the DVD reader of
the system that is hosting the Windows Deployment Services.
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2. Copy all the Windows Server 2008 (SP2 or R2) catalog files into the Catalogs
folder of the device driver repository.

For example:

copy DVDDrive:\source\*.clg C:\Unattend\Drivers\{WSK8|W28R2}\
Catalogs

3. Launch the Windows System Manager application and create a new
ImageUnattend.xml Setup Script by doing the following:

a. Click Start-->All Programs -->Microsoft Windows AIK -->Windows
System Image Manager.

b. In the Answer File pane, right-click and select New Answer File.

c. If a message dialog appears asking to open a new Windows image now, click
No.

4. Do the following to specify the Windows Server 2008 (SP2 or R2) Catalog file
that matches the Windows Server 2008 (SP2 or R2) edition (Standard,
Datacenter, or Enterprise) that you are installing:

a. In the Windows Image pane, right-click and select Select Windows
Image.

b. In the Files Type list box, select Catalog files (*.clg), then click Browse to
specify the Catalogs folder in the device driver repository.

Ensure that you select the Catalog file that matches the Windows Server 2008
(SP2 or R2) edition you are installing

For example, for Windows Server 2008 SP2 Datacenter, select:

C:\Unattend\Drivers\{W2K8|W2K8R2}\Catalogs\
install_Windows_Server_2008_SERVERDATACENTER.clg
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5. Do the following to set the component packages to
pass 2 offlineServing.

a. In the Windows Image pane, click and expand the
architecture_Microsoft-Windows-PnPCustomizationNonWinPE_vers
ion.

b. Right -click PathAndCredientials and select Add Setting to Pass 2
OfflineServing.
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6. Repeat Step 5 for each device driver you want installed during the Windows
Server 2008 (SP2 or R2) installation.

Refer to TABLE E-2 for the list of device drivers to include in the install.wim
file.

7. Do the following to specify an installation key value.

a. In the Answer File pane, click and expand
2 offlineServicing,architecture_Microsoft-Windows-
PnPCustomizationsNonWinPE_version.

b. Click and expand PathAndCredentials and enter a sequence key value as
well as the UNC device driver path in the repository.

For example, to add the device driver for the Sun Storage SAS RAID HBA
option, enter:

Key 1

Path \\wds-server\W2K8-Drivers\Lsi\1.19.2.64
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c. In the Credential section for each PathAndCredentials component, click
and expand the component to insert the UNC domain, logon, and password
(if required), which allow access to the device drivers stored in the
repository.

For example:

d. Repeat Steps 7a through 7c for each device driver you want installed during
the Windows Server 2008 (SP2 or R2) installation.

8. Validate the ImageUnattend.xml file using the Windows System Image
Manager application:

■ In the Windows System Image Manager application, click the Tools menu
and select Validate Answer File.

A message appears in the Message pane indicating that No Warnings or Errors
are found.

Domain UNC_domain

Password UNC_password

Username UNC_username
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9. Save the .xml Setup Script as ImageUnattend.xmlusing the Windows
System Manager application:

a. In the Windows System Image Manager application, click the File menu
and select Save Answer File as.

b. Save the .xml Setup Script in the device driver repository as:

c:\Unattend\Drivers\W2K8\Catalogs\ImageUnattend.xml

c. Exit the Windows System Image Manager application.

10. The creation of the ImageUnattend.xml Setup Script is complete. Proceed to
one of the following:

■ For Windows Server 2008 R2 installation, proceed to “Map
ImageUnattend.xml Setup Script to Windows Server 2008 (SP2 or R2) Install
Image” on page 65.

■ For Windows Server 2008 SP2 installations, proceed to “Add Device Driver(s)
to Boot WIM – Windows Server 2008 SP2 Only” on page 62 prior to mapping
the ImageUnattend.xml Setup Script to the install.wim image.

▼ Add Device Driver(s) to Boot WIM – Windows Server
2008 SP2 Only

Note – If you are performing a Windows Server 2008 R2 installation, skip this
procedure. Device drivers are not required at boot time for Windows Server 2008 R2
installations.

For Windows Server 2008 SP2 installations only, perform the following steps to add
the appropriate SAS HBA LSI device driver (MegaRAID or MPT2) to the boot.wim
image. Note that if the required SAS HBA device driver (as described in TABLE E-1
and TABLE E-2) is not added to the boot.wim image, the Windows Server 2008 SP2
installation will fail.

1. Insert the Windows Server 2008 SP2 DVD media into the DVD reader of the
system that is hosting the Windows Deployment Services.

2. Perform the following to launch the Windows Deployment Services
Administration tool and import the Windows Server 2008 SP2 Boot WIM.

a. Click Start -->All Programs -->Windows Deployment Services.
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b. Right-click Boot Images and select Add a Boot Image, then click Browse
to specify the Windows Server 2008 SP2 boot WIM file.

For example: DVDDrive:\sources\boot.wim

Click Open then Next.

3. To import the Windows Server 2008 SP2 boot image, click Next twice then
click Finish.

4. Disable the Windows Server 2008 SP2 boot WIM using the Windows
Deployment Services Administration:

■ Click and expand Boot Images, right-click Microsoft Windows Server
(Setup)x64, then select Disable.

5. Launch and run the Deployment Tools Command Prompt as Administrator.

For example:

■ Click Start -->All Programs -->Microsoft Windows AIK, then
right-click Deployment Tools Command Prompt, and select Run as
Administrator.
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6. In the Deployment Tools Command Prompt, perform the following:

a. Use mkdir command to create a temporary directory mount point to mount
the Windows Server 2008 SP2 boot WIM image.

For example:

mkdir C:\Mnt

b. Use the cd command to change the directory to the folder containing the
Windows Server 2008 SP2 boot WIM.

For example:

cd DVDDrive:\RemoteInstall\Boot\x64\images

c. Use the imagex command to mount the Windows Server 2008 SP2 boot WIM
with read/write permissions to the temporary directory mount point.

For example:

imagex /mountrw boot.wim 2 C:\Mnt

d. Use the cd command to change the directory to the device driver repository
containing the Windows Server 2008 SP2 device driver for the Sun Storage 6
Gb SAS RAID HBA option (SG-SAS-R-REM-Z or SG-SAS-R-EM-Z):

For example, to change to the directory containing the LSI device driver for the
Sun Storage 6 Gb SAS RAID HBA option (SG-SAS-R-REM-Z or
SG-SAS-R-EM-Z), type:

cd C:\Unattend\Drivers\W2K8\lsi\1.19.2.64
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e. Use the peimg command to add the LSI MegaRAID device driver for the
Sun Storage 6 Gb SAS RAID HBA option (SG-SAS-R-REM-Z, or
SGX-SAS-R-REM-Z, or SG-SAS-R-EM-Z) to the Windows Server 2008 SP2
boot WIM image.

For example, to add the LSI MegaRAID device driver for the Sun Storage 6 Gb
SAS RAID HBA option (SG-SAS-R-REM-Z, SGX-SAS-R-REM-Z, or
SG-SAS-R-EM-Z), type:

peimg /INF=*.inf C:\Mnt\Windows

f. Repeat Steps 7d and 7e for each additional device driver (as described in
TABLE E-2) that is required in the boot WIM image:

■ Sun Storage 6 Gb SAS HBA option (SG-SAS-REM-Z or SG-SAS-EM-Z).

■ Intel Network Driver

g. Use the imagex command to unmount and commit the modified Windows
Server 2008 SP2 boot WIM image.

For example:

imagex /unmount/commit C:\Mnt

7. To enable the Windows Server 2008 SP2 boot WIM image, do the following:

a. Launch the Windows Deployment Services administration tool.

Click Start-->All Programs-->Windows Deployment Services.

b. In the Windows Deployment Services (WDS) administration tool, click and
expand Boot Images.

c. Right-click Microsoft Windows Server (Setup) x64 and select
Enable.

8. The modifications to include the device drivers into the boot.wim image are
complete. Exit the Deployment Tools Command Prompt and the WDS
administration tool, then proceed to “Map ImageUnattend.xml Setup Script to
Windows Server 2008 (SP2 or R2) Install Image” on page 65.

▼ Map ImageUnattend.xml Setup Script to Windows
Server 2008 (SP2 or R2) Install Image
Follow the steps in this procedure to map the ImageUnattend.xml Setup Script
(created in an earlier procedure in this section) to the Windows Server 2008 (SP2 or
R2) install.wim.

1. Insert the Windows Server 2008 SP2 DVD media into the DVD reader of the
system that is hosting the Windows Deployment Services.
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2. Perform the following to launch the Windows Deployment Services
administration tool and import the Windows Server 2008 SP2 install WIM.

a. Click Start -->All Programs -->Windows Deployment Services.

b. Right-click Install Images and select Add Install Image.

Note that if no image groups exist, create a new image group named Windows
Server 2008 SP2 or Windows Server 2008 R2 and click Next.

c. Click Browse to select the Windows Server 2008 SP2 Install WIM image
located at: DVDDrive:\sources\install.wim; then proceed by clicking
Open then Next.

d. Select the Windows Server 2008 (SP2 or R2) edition (Data Center, Standard,
or Enterprise) to import into Windows Deployment Services, then click
Next.
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e. To import the specified Windows Server 2008 (SP2 or R2) edition install
image, click Next twice, then click Finish.

3. Launch the Deployment Tools Command Prompt as Administrator.

For example:

■ Click Start -->All Programs -->Microsoft Windows AIK, then
right-click Deployment Tools Command Prompt, and select Run as
Administrator.

4. In the Deployment Tools Command Prompt, perform the following:

a. Use the cd command to change the directory to the folder containing the
Windows Server 2008 SP2 install WIM image.

For example, the Windows Server 2008 SP2 Datacenter (x64) edition WIM
image would be located at:

cd Drive:\RemoteInstall\images\Windows Server 2008 SP2

b. Use the mkdir command to create a directory with the exact same spelling
and case as the imported Windows Server 2008 (SP2 or R2) WIM image.

mkdir install

Note – Selecting the defaults when importing the install image for Windows Server
2008 (SP2 or R2) will create an installation WIM file called install.wim.
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c. Use the cd command to change the directory to the imported Windows
Server 2008 (SP2 or R2) folder, then use the mkdir command to create an
Unattend directory.

For example:

cd install

mkdir Unattend

d. Use the cd command to change the directory to the unattend directory, then
use the copy command to copy the ImageUnattend.xml Setup Script
(created in an earlier procedure in this appendix) to the Unattend directory.

For example:

cd Unattend

copy C:\Unattend\Drivers\{W2K8|W2k8R2}\Catalogs\
ImageUnattend.xml

5. Perform the following steps to open the Windows Server 2008 (SP2 or R2)
image properties:

a. Launch the Windows Deployment Services administration tool.

Click Start-->All Programs-->Windows Deployment Services.

b. In the Windows Deployment Services (WDS) Administration tool, click and
expand the Windows Server 2008 (SP2 or R2) image group.

c. Right-click Microsoft Windows Server (SP2 or R2) and select
Properties.

6. Perform the following steps to map the ImageUnattend.xml Setup Script to
the Windows Server 2008 (SP2 or R2) image:

a. In the General Tab of the Windows Server 2008 (SP2 or R2) image properties,
check Allow image to install in unattended mode and click
Select File.

b. Browse to the following location (specified in Step 4d) then click OK.

Drive:\RemoteInstall\images\{W2K8|W2K8R2}\install\Unattend\
ImageUnattend.xml
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c. Click OK to map the ImageUnattend.xml Setup Script to the Windows
Server 2008 (SP2 or R2) WIM image.

The Windows Server 2008 (SP2 or R2) WIM image is ready to be installed via
Windows Deployment Services.

d. Exit the Deployment Tools Command Prompt and the Windows Deployment
Services Administration tool.

7. To deploy the Windows Server 2008 (SP2 or R2), refer to the following
procedure:

“Install Windows Server 2008 (SP2 or R2) Using PXE” on page 25.
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APPENDIX F

Identifying Network Interfaces in
Windows

This section includes information that can assist you when configuring Windows
network settings. Specifically, it provides information for identifying Windows OS
network interface settings for Oracle’s Sun Netra X6270 M2 server module.

Procedures for Identifying Network
Interfaces
The following procedures describe how to:

■ Determine which network ports are actively connected to a network. For details,
see “Determine Active Network Data Ports” on page 71.

■ Confirm the MAC addresses for the physical network ports and match them to
the Windows friendly device names. For details, see “Confirm Physical Port MAC
Addresses and Match Them to Windows Device Names” on page 72.

▼ Determine Active Network Data Ports
You can determine which network data ports are actively connected to a network by
using Microsoft’s Network Connections folder. To access the Network Connections
folder, follow this step:

● Click Start-->Settings-->Control Panel-->Network Connections

The Network Connections folder appears identifying the actively connected data
ports.
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▼ Confirm Physical Port MAC Addresses and
Match Them to Windows Device Names
To confirm the MAC addresses of installed network interface ports and to match
them to the Windows Device Friendly Names, you need to open a command prompt
and run ipconfig /all, as described below:

1. Click --> Start --> Run.

The Run dialog appears.

Figure Item
Number Description

1 An active port connection.

2 A red X marks the port connections that are currently inactive.

3 The port has been manually disabled (right-click to re-enable).
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2. In the Run dialog, type cmd then click OK.

The cmd.exe DOS window appears.

3. In the cmd.exe DOS window, enter the following command at the prompt:
ipconfig /all

The output from the ipconfig /all command identifies the installed network
interface ports by the connection name in the order of enumeration.

The output does not necessarily follow an alpha or numeric order. You can
customize the connection name in the Network Connections folder. For details,
see Microsoft’s documentation. The output below illustrates how the Windows
operating system, by default, assigns logical names to network interfaces.
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Figure Item
Number Description

1 Second Ethernet adapter port.

2 First Ethernet adapter port.
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